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HOW TO USE
THIS BOOK

Welcome to Artists’ Master Series: Perspective & Depth. This book contains
three main sections: the theory chapters, the tutorials, and the gallery.

We recommend that you begin by reading through Mike Hernandez's
introductory chapters on Perspective & Depth (page 8 to page 81) to
expand your knowledge and understanding of these fundamental
topics. Perspective & Depth Throughout History (page 10) explores how
they have been used in artwork through the ages. Types of Perspective
(page 16) discusses the various different types of perspective that
can be used to create the illusion of depth and realism, covering one-
point perspective all the way up to four-point and above, in addition to
schematic view, worm's-eye view, and bird’s-eye view. Foreshortening &
Depth of Field (page 34) explores alternative methods that can be used
to create a sense of distance without the need for measurements and
vanishing points, including looking at the placement of focus in the
foreground, middle ground, or background for storytelling purposes.
Next, Atmospheric Perspective & Depth Perception (page 44) examines
the role that wavelengths, colour, contrast, value, light reflection, and
the Fresnel effect play in achieving the illusion of depth. Unpacking
how shadows can be used to create a believable object in space,
Shadows (page 56) unpacks artificial and natural lighting, form and cast
shadows, linear and radial lighting, measuring shadows in perspective,
parallel perspective, and viewing shadows in the abstract. Shapes
(page 66) explores how perspective can be used to change the appearance
of shapes in a scene, with sections discussing depth cues, primitives, and
the use of grids. To finish, Breaking the Rules (page 74) suggests how the
established rules and principles can be intentionally broken to produce
certain artistic effects or to challenge conventional representations of
space, with sections on distorting perspective, including multiple or no

vanishing points, and flat, isometric, and curvilinear perspective.

The four Tutorials that follow, by Devin Elle Kurtz (page 84), Nathan
Fowkes (page 134), Orenjikun (page 168), and Guweiz (page 202), can be
treated as standalone projects, but you will benefit from reading the
knowledge and terminology shared in the introductory chapters before
starting them. Each tutorial artist has their own unique style, creative
background, and skilled approach to creating perspective and depth in
their artwork. Follow each tutorial in turn to observe how they apply
their knowledge of these core topics in practice.

Finally, the Gallery (page 256) showcases the portfolios of the fourtutorial
artists, plus six additional professionals, each of whom shares valuable
insights into their expert use of perspective and depth in their artwork.

Throughout the book, look out
for these useful coloured boxes,
where artists share pro tips and
bonus advice.
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& DEPTH

MIKE HERNANDEZ

 PERSPECTIVE

Perspective in art is the fundamental
technique that allows artists to represent
three-dimensional space onto a two-
dimensional surface. It depicts the way that
objects appear in relation to one another,
creating a sense of depth, distance, and
realism. Whether using linear perspective to
establish vanishing points and convergence,
applying isometric perspective for a more
stylized approach, or experimenting with
unconventional methods, a comprehensive
yet simple understanding of perspective
is essential for artists seeking to convey a
convincing and dynamic sense of space in
their art.
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PERSPECTIVE
& DEPTH
THROUGHOUT
HISTORY

Perspective in art has evolved through time from simple applications to sophisticated

techniques. It has played a pivotal role in transforming two-dimensional paintings

into immersive, realistic, and imaginative visual experiences. This chapter will take a

look at how perspective and depth have been used in art, from Egyptian hieroglyphs to
contemporary digital artwork.




MIKE HERNANDEZ

THE EVOLUTION OF
PERSPECTIVE & DEPTH

IN VISUAL ART

In visual art, perspective refers to the technique used to create the
illusion of depth and three-di ionali
surface, such as a canvas or a piece of paper. It is an aspect of

di : 1
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Western art that has evolved over centuries and various historical
periods, and its roots can be traced back to ancient civilizations.

The earliest known forms of perspective were used in ancient
Egyptian and Mesopotamian art, such as flat graphic hieroglyphs
and symbols (01). These cultures depicted objects in a way that
emphasized their importance, rather than striving for realism.

01 This image of an Egyptian hieroglyph carving shows an example of early perspective and depth through the use

of foreshortening. Notice how the right arm is placed over the left arm, suggesting the subtleties of depth and volume.

Image 0, iStock.com/Ramon Ivan Moreno Prieto




PERSPECTIVE & DEPTH THROUGHOUT HISTORY

02 This image of
Byzantine artwork
provides an example
of perspective cues.
Notice the volume
of the table, as well
as the hierarchy

of scale and size
implied by the figure

in the foreground.

03 This image, taken

Early Christian and Byzantine art were primarily focused on religious

subjects and spirituality (02), rather than the concept of perspective
itself. Figures were often shown in hierarchy, with people of higher
importance presented as larger in scale than those of lesser value.
In the Renaissance era, artists such as Lorenzo Ghiberti and Leon
Battista Alberti created the concept of linear perspective, where the

12

from the Gates of
Paradise (1401-1422)
by Lorenzo Ghiberti
in Florence, Italy, is
an example of early
linear perspective in

the Renaissance era.

illusion of depth was created by the use of converging lines to a single
vanishing point on the horizon (03). Artists such as Leonardo da
Vinci further refined the use of perspective in their art, which helped
to create the feel of accurate spatial representation (04, 05). These
refinements also spread to Northern Europe during this period.

Image 02, iStock.com/Socha

Image 03, iStock.com/M

ssimo Merlini




MIKE HERNANDEZ

05 school of Athens by Raphael is one of the most famous frescos of the Italian Renaissance for its accurate mathematical depiction of one-point perspective.

Image 04, iStock.com/Andrew_Howe 13

Image 05, pyty - stock.adobe.com




PERSPECTIVE & DEPTH THROUGHOUT HISTORY

In the nineteenth century, artists such as Edgar Degas and Claude

Monet challenged traditional perspective and focused more on
capturing the essence of lighting and atmosphere (06). Movements
like Cubism and Surrealism pushed the boundaries of perspective
even further, sometimes abandoning it altogether in order to achieve
a better sense of abstraction (07).

14

086 The Bridge at Argenteuil
(1874) by Claude Monet is

a great example of how
perspective evolved well

into the nineteenth century,
giving way to beautiful
images filled with light,

atmosphere, and depth.

07 still Life with Apples
and Pears by Cubist
painter Paul Cézanne
was a great departure
from the traditional

rules and standards of
perspective in that era.
Notice the statements
being made by the forced
awkwardness of the
vanishing points suggested
by the foreground table

and background wall.

In the early 1900s, the Modernist era of art rejected realistic depictions
of reality and were more concerned with experimentation and
innovation. Their thinking created new rules for how some artists
would go on to use design to first establish their artistic statement
beyond reality, then reinforce this idea with implied perspective.
Such an idea can be seen in the works of both Richard Diebenkorn
and Eyvind Earle.

Image 06, Everett Collection/Shutterstock.com

Image 07, Everett Collection/Shutterstock.com




In contemporary art, perspective continues to evolve. Artists in both

the entertainment and fine-art industries explore new techniquesand
concepts. Digital art, virtual reality, and social media have expanded
the possibilities for creating a more dimensional and immersive

Image 08, Old Oak © Mike Hernandez

MIKE HERNANDEZ

08 This digital painting

is an example of how
traditional thinking and
digital skill sets can come
together to bring a more
abstract experience, while
maintaining realistic depth

and volume in perspective.

experience. While traditional linear perspective techniques have
been used for centuries to create realistic depth and volume, many
contemporary artists now push the boundaries of perspective in
order to challenge and explore abstract concepts (08).

15
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MIKE HERNANDEZ

THE HORIZON LINE
& PICTURE PLANE

When studying depth and perspective, there are many aspects of
maths and theory that may at first seem daunting and intimidating
to the average layperson, leading them to avoid the subject matter
altogether. A good way to make the subject more approachable is
to break depth into four simple dimensions: one-, two-, three-, and
four-point (also known as multi-point) perspective.

For the purposes of our discussion and understanding of perspective,
you should always begin with a known horizon line (01). The horizon
line, or eye level, refers to a physical, visual boundary where the
sky separates from land or water. This is the actual height of the
viewer’s eyes when looking at an object, interior scene, or exterior
scene. Knowing where the horizon line is at all times gives the artist a
measuring point for perspective and depth in order to feel grounded
in the artwork.

Horizon line

01 The horizon line is the starting point in establishing perspective in a scene. It's where the

sky meets the ground plane, or water, and is also referred to as the viewer's eye level

17




TYPES OF PERSPECTIVE

It's also important to consider that paintings or drawings are
working within a picture plane (02), which is like a glass window
through which the viewer sees the subject. The scene beyond the
picture plane is where the volume and depth originates (03).

02 Here you can see the horizon level as it pertains to the viewer standing eye level to the picture

plane. The world beyond the picture plane is the painting and where you measure perspective.




MIKE HERNANDEZ

03 Four examples of how volume and depth are perceived beyond the picture

plane, dependent on the placement of the horizon and vanishing points.

Image 03, Ediza Lake, Tunnel Rock, Ireland Cliffs, and Oro Canyon © Mike Hernandez 19




TYPES OF PERSPECTIVE

SCHEMATIC VIEW

Let’s start with a cube in what is called the It represents a 90-degree angle from the apply several points of perspective. However,
‘schematic view’. This offers the face of viewer's eye. In order to see more views of  from this schematic view, you only see one
only one side of an object at any given view.  the object simultaneously, you wouldneedto  square face of the cube (04).

Horizon line

04 schematic view of a cube placed in our view, below the horizon line, without an

established vanishing point. As there is no perspective, this is considered frontal plane view.




MIKE HERNANDEZ

ONE-POINT PERSPECTIVE

When
point somewhere on the horizon line, this

introducing a single vanishing
creates a measuring point that allows you
to see another side as well as the top of
the square, creating a cube (05). This is

one-point perspective.

With one-point perspective, only one side
converges to the horizon, while the face
remains schematic, or square. By following
the lines connected to the corner of the
square, you will observe the cube become
increasingly smaller as the lines stretch
into the distance and finally meet at the

vanishing point on the horizon line.

One-point perspective has its benefits.
For example, you might want to show an
undistorted view of the face of a building,
while also showing its depth (06). This is
important if the focus of your artwork is the
object or building in the foreground needing
to be facing the viewer, in order to convey
proper proportion and storytelling. It’s also
a good option for artists who have little to

no understanding of complex perspective.

Vanishing point A

Horizon line

085 The first vanishing point on the horizon reveals two other sides of the square,

creating a cube in one-point perspective and an image with depth.

Sometimes a little perspective can go a long
way in conveying depth. Another advantage

of one-point perspective is the inherent

subtlety of distortion due to the limited
number of vanishing points of objects in

ascene.

06 This painting by Orenjikun is a great example of how to use one-point perspective in a scene. Notice the convergence of lines that

vanish to a single point on the horizon in the centre of the painting, while the left and right horizontal lines remain parallel

Image O¢

21




TYPES OF PERSPECTIVE

TWO-POINT PERSPECTIVE

If you introduce another vanishing point on the horizon line, across
from the first point, this provides the second measurement needed
to create two-point perspective. Now the cube takes on a different
dimension where you no longer see the square faces of the box, but
rather distorted sides that create volume and depth (07).

Two-point perspective presents an object from the side with two
vanishing points. It provides a realistic view of the object, as it
shows the item edge-on, as you would typically view it. Two-point
perspective is often used to produce realistic drawings of an object.
With its more neutral sense of distortion, it's often favoured by
contemporary outdoor painters who want to capture a simple and

neutral composition in landscape (08).

From a human point of view, we tend to paint within the confines of
our comfortable range of vision, which doesn’t usually cause much
distortion. This range is what is known as the ‘cone of vision’, which
will be discussed on page 80. When you paint within your cone of
vision, you minimize distortion and reduce the risk of having to
introduce too many dimensions and vanishing points. This is where
two-point perspective usually makes sense. It's not a hard rule, but
rather an average that can help you to instil a composition with a
simple, calm appearance.

Vanishing point A

Horizon line

Vanishing point B

07 The addition of a second vanishing point on the opposite side creates two-point perspective. Here you

can see three sides of the cube. Notice how the vertical sides of the cube lines are parallel to one another.

22
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TYPES OF PERSPECTIVE

THREE-POINT PERSPECTIVE

Adding an additional vanishing point forty-five degrees vertically
to the horizon line provides another measurement and creates
three-point perspective (09). Boasting yet more benefits, three-
point perspective provides the most realistic feeling of depth and
dimension for an object in a lifelike scenario. Humans tend to see the
world from a wide-angle view. Three-point perspective conveys that

view most accurately, without overly distorting the composition (10).

Vanishing point A

Horizon line

Another advantage is its ability to convey a low-to-high eye level.
For example, if you were standing at the base of a building, looking
up slightly, three-point perspective would create the illusion of that
distortion in volume (11).

Vanishing point B

Vanishing point C

09 Adding a third vanishing point 45 degrees vertically to the horizon produces three

point perspective. Notice the distortion where the side lines are no longer parallel

24




Image 10, Canyon de Chelly © Mike Hernandez

Image 1, Downtown Dragons

11 This digital painting by
Devin Elle Kurtz is another
example of how to use
three-point perspective
in a scene. Notice the
convergence of left and
right horizontal lines from
the buildings, as well as
the convergence to a
single vertical vanishing
point on top. Find the

tutorial on page 84.

MIKE HERNANDEZ

10 This digital painting of
Canyon de Chelly illustrates
three-point perspective

as viewed from a higher
point of view. Notice how
the vertical lines converge
to a lower vanishing point

beyond the picture plane,

25




TYPES OF PERSPECTIVE

FOUR-POINT

PERSPECTIVE & ABOVE

Most art and design work stays within the confines of one-, two-,
or three-point perspective, as moving beyond this causes further
distortion and what is called ‘fish-eye view’. Sometimes the inclusion
of distortions created by four-point perspective (or higher) is justified,
such as in production work with the use of multiple camera styles for
film and entertainment. The purpose of these shots in film would be

to cram as much information into the scene as possible (12).

The same effect is evident when looking through the peephole of

a door. To produce this type of measurement, you would use four-

26

point or multi-point perspective by adding in another vanishing
point 45 degrees above the horizon line (13). Perspectives using four
or more points are by far the most complex to master, as they require

additional mathematical calculations and measurements (14).

As for my personal history with perspective, asboth an art director for
animated films and a plein-air painter in contemporary fine art, I've
rarely ever felt the need to venture beyond three-point perspective.

One-, two-, and three-point have typically proved all I've needed.

12 This digital painting
of a downtown city scene
demonstrates the use
four-point perspective in
a more naturalistic way.
Notice the subtle vertical
distortion due to the view

outside of the cone of vision.




MIKE HERNANDEZ

13 Adding the fourth
vanishing point 45
degrees vertically
above the horizon
creates four-point
perspective. Notice the
rounded effect of the

cube on all four sides.

Vanishing point A Vanishing point B

Vanishing point C

14 Adding another
vanishing point in
the middle, radiating
outin a star-like

formation, produces

five-point perspective.

This is known as the

‘fish-eye view'".

Vanishing ;;oiqt E

\

Vanishing point C

27




TYPES OF PERSPECTIVE

WORM'S-EYE VIEW

If you were to force the three points of three-point perspective closer
together, while placing the viewer's eye level on the floor, this would
create what is called ‘worm’s-eye view’ (15). This view yields much
heavier distortions. Very rarely would you see this type of view in
a landscape painter’s artwork, as it requires you to lie on the floor
with your eye to the ground, looking up. You could, however, use
this method to create a more stylized feel in a scene (16), such asin a
movie where a character is experiencing vertigo from staring up at
the city skyscrapers towering above them. Worm's-eye view would

help to capture that sense of dizziness and overwhelm.

Another example of how to use worm's-eye view would be to capture
the hero motif. The term ‘hero’ does more than describe an important
character. It also conveys a sense of hierarchy in staging a scene.
Whether the painting is of a building, tree, or person, forced three-
point perspective in worm's-eye view can been used to achieve a more
heroic shape.

15 Worm's-eye view is a forced perspective created from a point of view looking up from below.

28
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16 This gouache painting from the Grand Canyon is a good example of worm’s-eye view, thanks

to the extremely low point of view looking up at the towering rock walls.

Image 16 Oro Canyon © Mike Hernandez 29




TYPES OF PERSPECTIVE

BIRD’S-EYE VIEW

The opposite can be achieved when looking down on an object from
an elevated viewpoint, described as ‘bird’s-eye view’ (17). This angle is
useful when artists wish to establish a greater scope and scale of an
environment. Examples of this could be figures looking down over a
cliff top (18), ora person overlooking the city from their high balcony.

An example of bird's-eye view used in film would be a dynamic view
looking straight down into a city street from the top of a skyscraper,
as is often seen in superhero movies such as Spider-Man. This type of
bird’s-eye view can also be achieved in four-point through to six-point

perspective, where the scene takes on that circular fish-eye lens look.

Vanishing point A Horizon line Vanishing point B

Vanishing point C

17 Pulling the vanishing points closer together creates a forced perspective that is also referred to as bird's-eye view.

30




MIKE HERNANDEZ

18 This gouache painting of Garrapata Beach, California, is a good example of

bird's-eye view due to the higher vantage point looking down on the rocks.

Image 18, Garrapatta © Mike Hernandez 3




TYPES OF PERSPECTIVE

Four-point through to six-point perspective is best used when you
wantachieve a truly dynamic sense of depth and distortionin a scene,
which is why it's rarely used in contemporary outdoor painting.
It's the least realistic way in which we view the world through our
eyes due to the limitations of our cone of vision. Interestingly, bird's-

eyeview can also be achieved in two-point perspective where the view
has a limited sense of distortion (19, 20). These types of perspectives
in bird’s-eye are typical in long-lens shots, which will be discussed

on page 214.

19 The illustration above is an example of bird's-eye view using two-point perspective. Notice the parallel vertical lines.

32




20 An example of the three basic levels, illustrated in two-point perspective.

Choosing which type of perspective to use for a painting is
an important decision, as it plays a crucial role in how an
artwork is perceived and how it communicates its message or

story. The type of perspective can influence the composition,

MIKE HERNANDEZ

——

e
Normal eye level

depth, and emotional impact of the artwork. It needs to work
well with the intended concept of the image. Artists should
consider what they want to communicate and choose the
perspective that best serves that statement.

33




FORESHORTENING
& DEPTH OF FIELD

While foreshortening and depth of field are sometimes thought of as the easier and less
impactful options, because they don’t involve mathematics or measuring vanishing
points, this is simply not true. Both take practice to achieve and can be used to create

impressive artwork.




MIKE HERNANDEZ

FORESHORTENING

Foreshortening can be described as the simplest form of depth in  length in the picture plane, ing a three-di ional look.
art. Itcreates theillusion of depth and perspective by shorteningan  Put simply, foreshortening is how an object appears much shorter
object through the use of overlapping forms and lines (01). Objects ~ when viewed from a sharper angle.

or figures are depicted at an angle that appears to shorten their

Horizon line

01 This illustration is a good example of how objects layered in space create a sense of depth and perspective.

35




FORESHORTENING & DEPTH OF FIELD

Raise your arm so it's pointing straight out
in front of you. By looking down the length
of your arm, starting from your shoulder,
you will notice how the various muscles
and anatomical parts overlap each other

and compress, making your hand appear

far away. Most of what you see in everyday
life is viewed with this foreshortening, as
everything in front of you typically overlaps
the other objects beyond. For example,
when walking down a street you will notice
storefront

buildings, signs, and shapes

overlapping each other. Similarly in nature,
you may observe hills or cliffs overlapping
one another as they recede into the
distance (02). Each object appears smaller
as it is overlapped by a larger object in front,

creating the illusion of depth (03).

—

02 This digital painting of sea cliffs in Scotland (above left) shows how simple and effective foreshortening can be, with the

layering of larger cliff shapes in the foreground to smaller ones in the distance. This is a very simple and effective way of achieving

perspective and depth. If we break down the scene into primitive shapes (above right), the effect is more apparent.

03 This painting by Guweiz is a great example of how to use foreshortening in order to achieve

volume in the foreground character. Notice how the overlapping of anatomical forms and the

layering of hair strands creates the illusion of depth. Find the tutorial on page 202




MIKE HERNANDEZ

With foreshortening, objects or body parts closer to the Exaggerating proportions in perspective can add depth,

viewer can appear larger than they would in reality. Don’t drama, and personality to your artwork.
be afraid to exaggerate proportions to emphasize this effect.

There are, however, exceptions. For example,
you might be looking at a smaller building
in front of a larger one. While you may think
that this situation would defy the rules of
foreshortening, it does not. Since the object
closest to you is still overlapping the one
further away, you will always perceive this
as order and hierarchy, which will then
create depth and perspective. It is just greatly
enhanced when the objects beyond are
smallerin comparison. Eventually,all objects
of equal size will appear smaller than one
another as they overlap and recede into the
distance, creating a compressed distortion.

COMPRESSION

Compression provides another form of
depth, distorting how distances change in
proportion as they recede. When viewing
a desert scene at eye level, for example,
the shadows from clouds cast onto the
foreground plane appear larger compared
to the compressed shadow shapes in the
distant middle and background planes. One
might assume that because each shadow
shape is thinner as it recedes, that they are
smaller shadows, when in fact they are the
same size. This is the illusion of compressed
space. A scene showing waves on the ocean
can also show compression in action (04).

04 This digital painting illustrates the principles
of foreshortening through compression of size
and space. Notice how the size and spacing

of waves progress from small to large as they
move forward from the vanishing point. The
largest wave in the front has also been greatly

exaggerated to imply forced perspective.

This gives the scene a deeper dynamic.

Image 04, Storm Caps © Mike Hernandez 37




FORESHORTENING & DEPTH OF FIELD

DEPTH OF FIELD

Depth of field is anotherimportant factorin how we perceive distance.
Objects appear to us as in-focus or sharper in the foreground, and
distant and out of focus in the background. The human eye can
generally only focus on one detail at a time, therefore we only
articulate details through hierarchy. Photographers also rely on
these principles through the technology of the camera. A zoom lens
and various camera settings will allow the photographer to focus on
objects near or far away. This allows the photographer the ability
to gain a sense of depth and staging of the subject. The eye has the
ability to do the same, but at a more accurate and faster speed.

One way to test this theory out for yourself is to place your finger
in front of your face and with both eyes open, focus on your finger.

Once your finger is in focus, look past your finger and focus on
objects beyond it. Now try focusing on your finger in front and
anything beyond it simultaneously. You will find this is impossible
because of the rules of hierarchy (05).

As artists we can use this tool to understand depth of field as a way
of enhancing our subject matter in a painting. For example, you
could paint the subject in the foreground with more articulation and
sharpness, while painting the background loosely, to suggest depth
and focus. Watercolour or gouache artists can use a wet-on-wet
technique to make the edges of objects bleed in the distance, while
maintaining harder edges in the foreground. The wet bleed makes

the softer effect of objects appear out of focus.

Horizon line

05 This illustration demonstrates how objects in the foreground can appear sharper and more in focus,

while objects further away blur out of focus as they recede towards the horizon.
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THREE FIELDS

In general, depth of field can be broken up into three fields:
foreground, middle ground, and background. The foreground is
typically sharp, the middle ground soft, and the background softer
still (06). This isnota hard-and-fast rule, however. In cinematography,
photography, and any style of art or storytelling, you can place your
focus anywhere within these three fields.

MIKE HERNANDEZ

One intimate form of storytelling typically used in cinema is to
make the foreground and background out of focus, giving hierarchy
to the subject in the middle ground. This effect is also known in
photography as ‘tilt-shift’, where the foreground and background
perspective are greatly altered (07, 08, 09). This method places the
viewer in the foreground scene, peering into the middle ground

while keeping the distant details out of focus.

086 This image comparison demonstrates how depth of field can enhance a stronger sense of depth in a scene. The image on the right has been cut

into three simple fields, with the foreground being the sharpest in focus, the middle ground a little softer, and the background out of focus.

Horizon line

Out of focus In focus

07 Here you can see the tilt:
shift effect where the middle
ground is in focus while the
foreground and background
Out of focus remain way out of focus. This

effect gives the subject a more

intimate, miniature feel.
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Image 08,

08 This image demonstrates
the tilt-shift method. The
foreground and background
are out of focus, which gives the
subject in the middle ground
more focus and attention.
Tilt-shift can sometimes give
the scene a miniature-like
quality, depending on how far

the blur has been pushed.

09 Here is another digital
painting that illustrates the
tilt-shift effect, but with an
added bokeh effect. The bokeh
adds more of a blown-out
colour and light effect to

the highlights in the blurred

regions of the image.

we in Snow © Mike Hernandez

Image 09, Umpqua River ® Mike Hernandez



A great tool in Adobe Photoshop is the Iris filter, found in the Filter
menu under the Blur gallery. This filter will focus on any part of the
painting you choose, blurring out from the centre of interest to create
ashallow depth of field. A similar yet slightly different method can be
found in macro photography, where the subject in the foreground is

Horizon line

INfOCUS mmm——

Image 1, Lil’ Red © Mike Hernandez

MIKE HERNANDEZ

sharp and in focus, set against a very out-of-focus background (10, 11).
Both examples can be seen in cinema through a technique called ‘rack
focus’. This is where the camera moves from focusing on a subject in

the foreground to focusing on the background instead, or vice versa.

10 This illustration
demonstrates what is known as
the macro effect, where objects

in the extreme foreground

Out of focus have a sharp focus, while the

~

middle ground and background
are completely out of focus.
This effect can give images a

photographic or cinematic look

T This digital painting is a
perfect example of the macro
effect. The object in the
foreground is in crisp focus,
while the background is blurred
and completely out of focus.
This yields a more intimate

look to the subject matter.

(See page 46 for a further

explanation of the bokeh effect)
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As an artist working in the worlds of both production art and fine
art, I tend to use these methods unilaterally. For example, it would be
difficult to justify the use of a macro effect in an outdoor landscape
painting, as it's unlikely that I'd be painting something so close-up.
When landscape painting outdoors, I tend to stage my focus on
subjects with more articulation and harder edging, while using
broken or softer edges to create that sense of push-and-pull depth in
a scene (12).

In cinematography for animation, however, I rely heavily on the
use of depth extremes by pushing and pulling fields even further
apart than is seen in contemporary outdoor painting to get the
viewers' attention faster (13). In cinema, you only have split seconds
to make the audience look where you want them to, whereas with
contemporary outdoor painting, the viewer has more time to
appreciate the first, second, and third read. This is where subtlety can
play a part in outdoor painting.

12 This image is a good example of how a traditional painter can use depth of field in plein-air painting. | painted this gouache

image outdoors in the High Sierra within a creek setting. The scene was very busy with lots of scattered trees, textures, and

lighting, but | wanted to keep the middle-ground creek in focus while maintaining the scope of the forest. | achieved this by

loosening up my strokes and losing details in the foreground and background, giving the scene a tilt-shift-like quality.
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13 This digital painting is an example of how | push volume and dimensional extremes in my industry

work by applying a radial zoom to the perspective in order to achieve a more focused effect.




ATMOSPHERIC
PERSPECTIVE
& DEPTH
PERCEPTION

This chapter will discuss the theories and practicalities of atmospheric perspective as
it pertains to depth perception through colour, contrast, value, details, simplification,
and grouping. As humans, we depend on these attributes in order to perceive depth and
distance beyond the perspective of shapes. Atmosphere creates a sense of hierarchies
that inform us of the depth in front of us. Ever since the day we were born, we've been
calibrating our distances and awareness in space based on these principles.
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ATMOSPHERIC PERSPECTIVE
& THE ILLUSION OF DEPTH

Atmospheric perspective, also known as
aerial perspective, creates the illusion
of depth by the definition of objects
appearing less clear and less saturated the
further they recede from the viewer. The
method goes back as far as the Pompeiian-
style frescos (01), dating as early as 30
BCE, and Leonardo da Vinci’s lessons on
painting (02) where he stated: ‘Colours
become weaker in proportion to their
distance from the person who is looking
at them.’ Polymaths such as Leon Battista
Alberti also wrote explanations of the
effects of atmospheric perspective. One of
the strongest contributors to atmospheric
perspective is the many particles in the air.
These particles can range anywhere from
the microscopic to the granular, including
elements such as moisture, fog, dust, smog,

and chemicals.

01 Villa de Livia, jardin (v. 30 av JC). Fresque, Museo Nazionale Romano, Rome.

This fresco from Pompeiian art demonstrates an early understanding

of atmospheric perspective through contrast and colour.

02 Mona Lisa (circa
1503-1519) by Leonardo
da Vinci. Thisis a

perfect example of

how Leonardo used
atmospheric perspective
to convey a sense of
depth and vastness in
this scene. Notice the
warmer colours in the
foreground compared to
the cooler grey colours

in the background.
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As light rays pass through these particles,
they have a scattered effect that tends
to create a more opaque quality in the
atmosphere. The degree of scattering will
depend on the amount of particles in the
air. Think of a foggy day where you're

driving down a road and can only see objects
within thirty feet in front of you. This effect
becomes exaggerated when you increase
the brightness of light by turning on your
full-beam headlights; as a result, the light
becomes more scattered and opaque. Artists,

photographers, and filmmakers can enhance
this effect by using an optical effect called
bokeh. Bokeh is an aesthetically pleasing
blurry effect found in out-of-focus areas in
a photograph (03).

03 This painting captures how moisture particles exaggerate the effect of light scatter in atmosphere, creating a light bokeh effect.
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THE SCIENCE OF
WAVELENGTHS

Another aspect of atmospheric depth is the
science of wavelengths. The sky is made up
of many coloured wavelengths. Among those
colours are blue and red light photons (04).
Blue light has much shorter waves, with
wavelengths between around 450 and 495
nanometres. Red light has longer wavelengths
of around 620 to 750 nanometres. Between
these two wavelengths, blue light has a higher
frequency, and therefore it carries more energy
than red light. When light passes through
these wavelengths, different effects are created
based on the corresponding colour of light. As
blue light has the higher frequency, it will also
have the greater degree of light scatter. This
is why the furthest and darkest objects tend
to have a bluish cast on them, whereas longer
red wavelengths of light scatter the least and
show up on lighter distant objects. The reason
for this is the blue cast is lost in the light values
in the distance, revealing the weaker red left
behind in the highlights (05).

The sun, as we know it, burns reddish-yellow,
but it emits all spectrums of colour through a
process called RGB light (red, green, and blue),
which is additive light. When you add all three
of these colours together in light, it creates
white, and therefore sunlight is white. The
reason we perceive it as warm light is due to
the weaker and shorter wavelengths of yellow,
orange, and red trying to pass through the
blue scatter in the sky. The longer wavelengths
of yellow and orange that pass through our
atmosphere without much scattering or
absorption are what are left over. When the
sun is at its brightest and directly above us, the
light scatters through the shorter blue photons,
creating a blue hue to the sky. When the sun’s
brightness is at its weakest and the angle of
light passing through the atmosphere is longest
at sunset, you can see the additive effects of the
weaker wavelengths of yellow, orange, and red
scattered throughout the atmosphere.

Image 05, Frozen Falls, Yosemite © Mike Hernandez

04 This image illustrates the wavelengths of both blue and red photons. Shorter wavelengths, like

blue, are diffused by the atmosphere more than longer red wavelengths, causing the sky to have a blue

cast. The longer red wavelengths travel further through the atmosphere without much scattering.

Red wavelengths

Blue wavelengths

05 This painting of Yosemite National Park is a good example of how blue and red
wavelengths affect landscape. Notice the warmer light as it appears on the distant

rock in higher value, as opposed to the cooler light in lower value shadow.
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COLOUR, CONTRAST,

& VALUE

Through colour perspective, warmer colours appear closer to the
viewer'’s eyes due to the absence of atmospheric particles scattered
by blue light. Among the weakest of these warm colours is yellow,
since its colour saturation point is around eighty to ninety per cent
value range, so it tends to fall off first in the foreground (06). This is
why colours like greens and oranges hold their fullest saturation in
the foreground, then recede into greyer and weaker versions in the
distant blue scatter (07).

Most foreground colours will eventually recede into a blue, grey, or
violet shade in the distant landscape, producing a beautiful hierarchy
of depth through colour (08). Colours of higher importance have
more saturation and typically grab your attention most. This is how
we use nature’s hierarchies of colour to discern the objects that are
closest to us and of more immediate importance. Even cooler objects
will have more colour and attention in the foreground than in the
background. All colours, warm or cool, will eventually lose their

saturation as they recede into the distant landscape (09).

06 These two gouache paintings convey how particles create a sense of haze and fall-off from

foreground to background. Notice the lack of contrast and colour in the distant mountains.

Atmospheric colour perspective

48

07 spring in Southern
California (1931) by
Granville Redmond
demonstrates the
levels of loss as certain
colours recede into the
distant atmosphere.
Notice how yellow and
green recede faster,
while blues hold their

colour further out.

Image 06a, The Healing Trail © Mike Hernandez

Image 06b, Just One More Mike © Mike Hernandez
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08 This painting of Keyhole Arch, Laguna Beach, illustrates how all colour loses its saturation and contrast

as it recedes into the distance. Notice how all of the colours eventually turn towards a violet-grey-blue hue.

09 This painting of the Eshaness Cliffs in Scotland shows how warm colours in the foreground recede to cooler colours in the background.

Notice the warmer shadow colour in the foreground rock. This represents the local colour of the rock without the blue wavelength

photons and atmospheric particles. The small hints of pink in the distant horizon represent hints of red photons on clouds.

Image 08, Keyhole Arch © Mike Hernandez 49

Image 09, Cliff of Eshaness © Mike Hernandez
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10 This digital painting by Nathan Fowkes is a great example of how to use
atmospheric perspective in a scene. Notice the use of higher contrast value and colour
in the foreground versus the higher key of colour and contrast in the background

This establishes depth and perspective through the use of hierarchy,

50

Contrastand valuealsoplayapartin establishing
hierarchies in perspective and depth. Because
of scattered particles and wavelengths of light
and colour, lighting from the sun affects the
atmosphere through contrast. There are fewer
particles of light scattered between our eyes and
objects that appear closer to us. Therefore these
foreground objects have fewer of the strong
blue wavelengths that would normally show up
in darker values such as shadows, making the
object appear closer due to having more contrast
between light and dark. As objects recede into
the distance, there are more particles scattered
between the viewer’s eyes and the object, making
the shadows appear lighter and bluer (10, 11).
This will also make objects appear further away

from the viewer's eyes.

In art, we can reinforce the concept of depth
through distant contrast by forcing shadows
and highlights much closer to one another than
they would actually appear. One artist who was
known for doing this was Albert Bierstadt. In
some of his sunset paintings where he pushed
atmosphere and distant scale, he would use
a method known as ‘simultaneous colour
contrast’ where the values of the shadows were
the same as the highlights. What set them apart
as sunlight and shadow was the use of warm

and cool temperature.

11 This image illustrates how
we perceive atmosphere and
haze through a layered process
of particles. The more particles
between the viewer and the
subject in the scene, the

more atmosphere there is.




12 This digital illustration shows how depth can be achieved by loosening

details and textures as the landscape recedes towards the horizon

MIKE HERNANDEZ

Details will also be lost in the distant
atmosphere due to the scattering of particles.
You will typically see more clarity in foreground
objects; they will tend to separate and become
more complex in the foreground, while bodies
of objects will appear to group together and
simplify in the distance (12). This phenomenon
is also due to the limitations of our mind when
handling too many details at once. The human
brain is designed to function on levels of
hierarchy and importance, not multiple tasks of
the same importance all at the same time. Our
minds are constantly reading the world and the
landscape in front of us, but we can't take it all
in at once. It would be like having lots of books
open and trying to read them all simultaneously.
You need to focus your attention on one book at
atime in order to read the words and appreciate
it fully. Thankfully nature has found a way
to help us by establishing these hierarchies
through atmospheric perspective (13).

13 This gouache painting is a good example of how to use simultaneous value and colour contrast to achieve depth in a landscape.

Notice how the distant highlights and shadows get closer together in value, while the temperatures of warm and cool set them apart

Image 12, Sawtooth Creek © Mike Hernandez

Image 13, Eshaness Gray © Mike Hernandez
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LIGHT REFLECTION &
THE FRESNEL EFFECT

Another aspect of perspective worth studying is its relationship  angle, the more the reflection of light. A good example of this would
to light reflection. One of these attributes is known as the ‘Fresnel  be standing at the side of a lake (15). When looking down into the
effect’. In general, the Fresnel effect is the observation of light lake, the water appears transparent. When looking further towards
reflection dependent on the angle in which it is viewed (14). The the horizon, however, the surface appears to be more reflective,

steeper the angle, the less reflection is visible to us. The shallower the  creating a stronger sense of depth (16).

14 This image illustrates
the Fresnel effect and
its influence on glancing
angles. The image below
depicts the Fresnel effect
on a frosted sphere,
creating a weaker
reflection on the centre
of our point of view and
stronger reflections as
/ / the light gathers towards
the edges, away from

- x our viewing angle.
Steeper vertical angle, Longer glancing angle
weaker reflection, and yields stronger reflection

more transparency

Stronger reflection
on edges

N

Weaker reflection
in centre
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15 This gouache painting
illustrates the Fresnel effect
asit relates to the lake in
perspective. Notice the
transparency in the foreground
water. As the lake recedes
towards the horizon, the

light reflection gathers and

becomes semi-opaque

16 This digital painting is
another good example of the
Fresnel effect as it relates to

the reflection on the water.

Image 15, Ed

Mike Hernandez 53

> © Mike Hernandez

Image 16, Cerulean B
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This phenomenon can also be observed in the sky (17). When looking
at the distant horizon, the light gathers to create an opaque quality of
light. When you look straight up at the sky, with the sun at an angle,

you will see a darker, bluer sky, suggesting less gathering of light or

Darker and more
transparent

photon particles. In other words, we almost glimpse the darkness
of outer space, but the blue scattering of photons from the sunlight
prevents that, instead presenting as a dark blue. This gradient effect

creates a strong sense of depth towards the lighter horizon.

yobab © Mike Herna
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17 This digital image
painted in three-point
worm'’s-eye view is a good
example of the Fresnel
effect as it relates to the sky.
Notice the lighter opaque
colour on the horizon and
its gradation towards the

upper dark-blue sky dome.
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FORM & CAST SHADOWS

Natural lighting is the sun or sunlight (01). Artificial lightingisany ~ home decor lighting, street lamps, car headlights, phones, and TV
light form created by humans, or any light that is not produced by  screens. There are two types of shadows created by these two kinds
the sun (02). Artificial lightsources include candles, torches, lamps,  oflighting: form shadows and cast shadows.

01 This digital painting of
rocks is a good example of
natural lighting from the
sun. Notice the parallel effect
of the shadow shapes cast

across the ground plane

02 This digital illustration of a city street scene depicts artificial lighting used in a night-time setting. The only hint of natural

light can be seen on the distant horizon due to the scattering of red wavelengths from the setting sun.
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SHADOWS

Form shadows fall within an object, on its surface, while cast
shadows fall outside of an object. On a form shadow, there is a core
or terminator point where the light and shadow are divided (03). This

is what creates that solid architectural structure of light and shadow

in landscapes. The terminator is also where the light can no longer

Form shadow

Cast shadow

58

reflect onto the object, therefore moving past it until the light hits
another object, such as the floor. You can then observe the silhouette
of the terminator cast onto the floor or object adjacent to the lighting
direction, which creates the cast shadow. Think of a cast shadow as a
‘mimic’ of the object it is casting from.

03 The image of
the sphere, lit by a
single light source
from the upper
right, reveals the
light and shadow
play between
form and cast
shadows. Notice
the split between
light and shadow
on the sphere
that creates

the dividing

terminator line.
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Shadows can have soft or hard edges, depending on the powerful light source, such as the sun. Hard and soft shadows
light source and the surface. Soft shadows are often seen in  also play a role in drama. Hard shadows typically create a
diffused lighting, such as a lamp light with limited reach, dynamic look, while softer shadows lend themselves more
whereas hard shadows typically occur with a concentrated, towards romance.

e

This gouache painting shows how natural light, such as sunlight or, as seen here, bright

reflected moonlight, creates hard and sharp cast shadows in the landscape.

This acrylic painting illustrates how sunlight is diffused through clouds, creating softer shadows on the mountainscape,

while balancing harder shadows in other areas that are not obscured or diffused by cloud coverage.




SHADOWS

LINEAR & RADIAL LIGHTING

Now that you're familiar with the basic differences between the light
sources and shadow types, you can move on to how to measure them
in perspective. To do this you must first understand that there are
only two types of lighting in perspective. One is radial lighting and
the other is linear or parallel lighting (04).

All lighting is radial to begin with, which is to say that light radiates
in all directions, like a star. The sun is a star that radiates lines of
light from all sides. However, when you take one very small section
of those light rays directed towards our planet, you only receive a
limited range of lines. We perceive this small range of light rays as
parallel or linear light, seeming to shine in only one direction (05,
06). This is due to the larger size of the sun in comparison to our
very small planet and the vast distance between them. Artificial light,
such as from a light bulb, is radiant like the sun, and we see it as

radiant rather than linear due to its smaller size and close proximity.

Linear or parallel lighting

o
IS

Radial lighting

Linear and radial light usually only apply to the light rays from the
source light and the directions or distortions of the cast shadow
from the object. When using linear lighting in perspective, the cast
shadow lines will be parallel to one another. In radial lighting, the
cast shadows will distort in a fan-like direction away from the object.
The closer the light source is to the object, the greater the distortion.
This is why the sun’s lighting appears parallel, due to its immense
distance from anything on our planet. The best vantage point to see
this example is from a bird’s-eye view of people walking on the street
in a sunset environment. Take note of how parallel all of the shadows
are in a crowd. The best way to demonstrate radial lighting would
be to place multiple objects around an artificial light source. Notice
the distortions of each individual shadow, as well as the star-like
directions of all the shadows as they radiate away from the centre of
the light source (07).

04 These diagrams
use a sphere to
illustrate the
differences between
linear and radial
perspective in
lighting. The yellow
lines represent the
key light direction
and the magenta
lines represent cast

shadow direction.

05 This gouache painting captures how sunlight creates parallel shadows in landscapes. Notice all of the small,

medium, and large cast shadows on the mountainside, as well as the long shadows on the ground plane.
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06 This digital painting of Roman architecture is another good example of natural sunlight creating parallel shadow shapes.

07 Here objects are placed around an artificial light source to demonstrate radiant

light, which radiates in all directions and casts individual shadows.

Image 06, Arch of Constantine © Mike Hernandez 61
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MEASURING SHADOWS
IN PERSPECTIVE

To measure any kind of shadow in perspective, you should always
start with a ground plane, as this will allow you to create vanishing
points from which to measure objects and lighting. In the case
of sunlight, you would start with a point above the ground plane
to create the primary light source (the sun). This will act as the
measuring point for your light direction. From there you will draw
a vertical line down to the ground plane. This will be the measuring
point for your cast shadow. Once you have both of these points, you
can connect them to their corresponding points on an object and see
how it will cast a shadow (08, 09).

For a three-dimensional example that isn’t too complex, let’s look at
a cube (10). From the light source (sun) point, you can draw a line

that touches all of the outside top points of the cube, then from those

Vertical
measuring line
to ground plane

N

One-
dimensional

object plane \

/

Cast shadow direction line

points continue onto the ground plane. You can then draw lines from
the cast shadow measuring point on the ground plane to the outside
bottom points of the cube, and then past those points until they meet
with the light source lines. Once you connect these intersections, it
creates the map for the form and cast shadow.

When measuring for fixed or artificial light, such as a street lamps
or indoor light, you can follow exactly the same methods as above,
except you don’t need to measure cast shadow lines from the ground
plane. You would find this measuring point by drawing a line
vertically from the light source, then plotting a point somewhere
on the ground plane behind the object. This would indicate that the
light is somewhere within close proximity of the object being cast, as

opposed to a place on the horizon that indicates the distant sunlight.

/ Primary light source (sun)

Light ray direction line

Shadow area

08 This diagram shows the use of a primary light source (the sun) in one-point perspective on a one-dimensional object in

space to create a shadow area. The shadow is created by connecting the light to the top and bottom points of the plane
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Primary light source (sun)

Vertical measuring

line to ground plane
= = ———— Light ray direction line

One-
dimensional
object plane

Cast shadow direction line

Shadow area

09 This image represents lighting a one-dimensional object in two-point perspective by measuring the top and bottom-most outer points of the plane.

Primary light source (sun)

Vertical measuring
line to ground plane

\ Light ray direction line
Three-

dimensional

object plane \

Shadow area

Cast shadow direction line

10 The image above illustrates how lighting a three-dimensional cube using three-point perspective can create more volume and form.
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PARALLEL PERSPECTIVE

A simpler method of drawing shadows cast by sunlight is to use  directional lines for cast shadow direction. The only similarity here is
parallel perspective. This method doesn’t require you to find the that you will be connecting these points to the top and bottom outer
vertical measuring points like before, rather you are only using points of the cube to get the dimensions. Where these lines meet will
parallel directional lines for sunlight direction and parallel determine the form and cast shadow shapes (11).

Sunlight
direction

Cast shadow
direction

11 This image illustrates a simpler method of using parallel perspective in sunlight, without having

to find measuring vanishing points for the sun's rays and shadow direction
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VIEWING SHADOWS
IN THE ABSTRACT

Understanding the science of light and shadow in perspective is
essential for an artist to learn, but in order to comprehend a better
sense of design aesthetic, beauty, and style, this is only the beginning.
It's important to look at light and shadow as a way to make literal
sense of our environment, but it's also essential to view shadows
in the abstract. Most people who will view your artwork are more
interested in the aesthetic and appealing aspects of the image, rather
than the literal sense. True, art is in the eye of the beholder, but you
as the artist need to know that you can break or enhance the rules in
order to make your artistic statement.

As a designer in the animation industry, I found it very useful to be
able to create art and environments that communicated the story
with more accuracy and tone, but then when I would paint from life,
I'would sometimes feel limited by what was in front of me. I began to
take the lessons I had learned as a storyteller in animation and apply
them to the real world; which is to say that I always tried to create a
narrative or be intentional with my outdoor painting.

Looking atshadow shapesin the abstract helped meto take advantage

of tools I could use in storytelling or to direct the eye. Cast shadow

shapes, for example, could point in a particular direction or frame
a subject matter. Cast shadow lines could also be used as mood
stabilizers to convey excitement or calm, depending on whether the
edge was busy or uninterrupted. Shadows can be used to create more
form and depth by layering them over other objects. I would often
cheat this effect by having an unjustified shadow just cast across a
large middle-ground or foreground object, giving it more depth and
dimension. The viewer’s eye would never think to question it if it felt
balanced in the scene or in the context of the lighting. If the object
casting the shadow was off screen, we could assume that it could
do that.

It is also important to consider the ratio of light to shadow when
mapping out shapes in a scene. A good rule to follow is the golden
mean or golden ratio. There is some maths required to create the
golden ratio, but in simple terms it is best described as a seventy-to-
thirty ratio. These ratios can be pushed and pulled in order to achieve
various visual dynamics. For example, a ratio of twenty per cent light
to eighty per cent shadow will have a very dramatic look, giving the

scene a different mood (12).

12 This gouache painting
depicts the proportions of the
golden ratio. The painting on
the left depicts a relatively close
80/20 proportion of sunlight

to shadow, while the painting
on the right and diagram
below illustrate a ratio of 70/30
proportion. These types of
proportions yield a stronger

dynamic of dramatic lighting.

\.

Image 12, Oro Canyon © Mike Hernandez
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DEPTH CUES

If we were to dissect the various different shapes that make up a
landscape and think of them more as flattened puzzle pieces, rather
than volumetric shapes, we can explore how the abstract shapes
inform us about the direction and movement the viewer’s eye can
take into and through the composition. These are known as depth
cues (01, 02). In landscape or city scenes, the eye is drawn away

Vanishing
point

MIKE HERNANDEZ

from complex textures and instead drawn to simple paths first,

adi

streets,

such as trails, p: and groups of shapes
moving in one direction (03, 04). This tells us that the eye is drawn
to the path of least resistance, which we can use to our advantage in

acomposition.

Depth cues

01 This illustration of a rock in one-point perspective is a good example of how shape cues inform us of depth. The front-facing plane has a square-like shape,

while the side creates distorted shapes that point towards the horizon. Simple shape changes like this are a great way to imply perspective and depth.

02 The foreground in this gouache painting has been broken down into several puzzle-like pieces to reveal the shape cues that inform perspective and depth.

Image 02, Picture Peak © Mike Hernandez
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03 These two gouache
paintings are good
examples of how I've
utilized simple depth cues
in a scene through the use
of ariver or trail to create
an entrance that brings

the viewer into the image.

04 This gouache painting is another example of how a simple but less revealing shape can create a strong entry into a painting,

while also enhancing depth and perspective. Notice how the shape guides the viewer's eye to the castle.

68 Image 03a, Taylor Trailhead © Mike Hernandez

Image 03b, Eastern Sierra © Mike Hernandez




05 This gouache painting illustrates how | break down a scene into shape

cues and leading lines to enhance depth, direction, and perspective.

Image 04, Atrani © Mike Hernandez

Image 05, San Fernando © Mike Hernandez
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Perspective will enhance this effect by drawing
these shapes towards vanishing points (05). For
example, when a geometric rock shape in one-point
perspective turns away from our point of view,
revealing the other side of the object vanishing to a
point on the horizon, the front of the cube parallel
to the picture plane will look square or flat, while
the other side that vanishes towards the horizon
changes its shape. This distorted shape creates an
arrow-like movement that points us towards the
horizon. This also applies to non-geometric shapes,
such as trees and clouds.
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SHAPES

PRIMITIVES

A useful exercise to train your eye to notice these cues in organic
shapes is to break them down into primitives, such as squares,
triangles, and rectangles (06). This reinforces a better sense of
architecture and structure in an organic scene, helping to inform
perspective (07). Clouds are a perfect example of an ambiguous
subject matter for structure, as they often lack straight lines and
easy-to-read shapes. This is because we see the world in its literal
sense, rather than applied design. By applying design to cloud shapes,

we can reveal a simple structure of form that we can then place into
perspective, creating more depth and volume (08). Learning to apply
this method to all of the natural and ambiguous shapes in nature
will always yield a stronger sense of design, depth, and perspective.
Another bonus to simplifying shapes is that it creates a kind of
visual grammar - a set of rules or guides to help you break down
and interpret what you see. A further simplified look can help to

communicate a form of stylization in one’s own artwork.

i -5
e

06 This gouache painting is a good example of how to break down forms into simple primitives,

such as squares, rectangles, triangles, and cones, to help create a better sense of dimension in a scene.

07 This digital painting also shows how to break down complex and organic shapes into primitive building blocks, then apply them to

perspective in order to achieve depth. When | simplify shapes into geometric forms, it helps to establish a stylized look to my paintings.
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Image 06, Diamond Rock © Mike Hernandez

Image 07, Rivendale © Mike Hernandez




Begin by practising with basic geometric shapes, such as cubes, spheres, cylinders, and
pyramids. These forms are known as primitives and are excellent for mastering the

fundamentals of perspective. Add the details gradually after first establishing the basic
shapes. As always, observe real objects and how their shapes change when viewed from

different angles and perspectives.

Image 08, White Giants © Mike Hernandez

MIKE HERNANDEZ

08 This digital painting
of clouds is a good
example of how | use
primitive blocks in
perspective to enhance a
better sense of structure,

form, volume, and depth.
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SHAPES

GRIDS

Grids are another very useful tool for creating and understanding
depth and perspective in a landscape, while also enhancing form
and volume in shape. They are also helpful in understanding how
to measure the foreshortening of objects and the eyeballing of ratios
in space. By placing simple grids in a scene and dissecting them into
planes, they reveal a lot of information about how the form changes
direction and movement. A grid reveals the volume and simplicity of

forms, plus how they relate to one another in scale. A great example
of how a grid can be useful in a complex scene is to use one on a
mountain terrain with trees (09,10). By placing grids that are smaller
in the distance and larger in the foreground, you can use the squares
in the grids as measurements of how the trees relate to them by
ratio. This ratio can be applied to all objects, such as bushes, rocks,
and people.
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09 Here I've taken a gouache painting and applied grids to illustrate form, depth, and dimension. Notice the progression

from smaller grids in the background, to larger ones in the foreground. This creates a better sense of foreshortening.

10 Here is another of my gouache paintings where I've applied grids to the middle ground and foreground to illustrate depth by ratio and

proportion. Notice how the size of the trees and bushes correspond in size and shape with the grids as they recede into the landscape.

10 Aqui hay otra de mis pinturas gouache donde he aplicado cuadriculas al término medio y al primer plano para ilustrar la profundidad
mediante proporcién. Observe como el tamaiio de los drboles y arbustos se corresponde en tamario y forma con las cuadriculas a medida que

retroceden en el paisaje.
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Image 09, Temple Crag © Mike Hernandez

Image 10, Finger Lake © Mike Hernandez
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Grids can also be useful in enhancing movement and direction in  applying them to the forms in an image, they will follow perspective,

perspective (11). Large land masses, such as mountains and hills,can ~ which creates leading lines for the viewer’s eye to follow. Leading

sometimes seem ambiguous, but with the help of grids they canactas  lines can be used in art and cinema to help guide the viewer, or the

pathways for the viewer’s eye in a scene. By taking simple grids and  subject, in storytelling.
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M This illustration is another good example of how grids reinforce depth and movement in a scene. Notice the leading lines that create direction and depth,
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DISTORTING
THE PERSPECTIVE

Artists sometimes choose to break the traditional rules of linear to create a sense of unease, or to emphasize specific elements in
perspective as a form of artistic experimentation. They may distort  their composition. This type of distortion can be seen in the works
or manipulate the perspective to create a unique and visually ofartists such as Salvador Dali, who used a technique called ‘crazy

compelling composition. This can lead to interesting and visually  perspective’ to create dreamlike and surreal scenes (01).

striking artwork. Artists may also deliberately distort perspective

01 The Persistence of Memory (1931) by Salvador Dalf demonstrates how compelling and innovative an image can be by

manipulating and distorting the rules of traditional perspective. Notice the dreamlike quality that this image evokes.

01 La persistencia de la memoria (1931) de Salvador Dali demuestra lo convincente e innovadora que puede ser una imagen al
manipular y distorsionar las reglas de la perspectiva tradicional. Observe la cualidad onirica que evoca esta imagen.

dall, DACS 2024 75
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BREAKING THE RULES

MULTIPLE OR NO
VANISHING POINTS

Artists might also use multiple vanishing
points, or even create scenes with no clear
vanishing points at all. This technique
creates a simultaneous sense of disorder
and rhythm and can feel otherworldly and
unique (02).

Another useful technique I was taught
when I first started work as a concept artist
at DreamWorks was how to split a single
vanishing point into two different points.
This allows the artist to open up a scene,
such as a city that appears too narrow or
too deep (03). By moving the points apart,
the artist has room to stage action in the
foreground, such as a character moment
where the background needs to function as
a backdrop rather than the focus.
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02 This illustration is a good example of how artists can manipulate the rules by

the use of chaos to create rhythm and movement. By creating broken mulitiple

vanishing points, the buildings take on an abstract stylization.
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03 Thisillustration
illustrates how a single
vanishing point can be
split into two separate
points in order to
open up a scene. The
character now has

a more breathable
staging area to

perform in isolation.

Split vanishing point A Split vanishing point B
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BREAKING THE RULES

FLAT, ISOMETRIC, &
CURVILINEAR PERSPECTIVE

Another method used in stylized art is flat perspective, which refers  representation of space (04). Artists may choose to use flattened
to a simplified or flattened version of traditional linear perspective.  perspective for symbolic or expressive purposes. The absence of
In this case, artists may choose to use some elements of perspective, depth can convey a sense of focus and attention on other aspects of
but simplify them to create a more stylized or less realistic the artwork, such as colour or composition (05).

04 This is a simple example of how flattened perspective can be used to convey a quick stylistic read without

volume. The only perspective cues used here are overlapping objects that create that subtle foreshortened look.

04 Este es un ejemplo sencillo de cémo se puede utilizar la perspectiva aplanada para transmitir una lectura estilistica rapida
sin volumen. Las tinicas claves de perspectiva que se utilizan aqui son objetos superpuestos que crean ese sutil aspecto de
€scorzo.
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05 This illustration also captures how flattened perspective can be utilized to create an

artistic statement. Notice how all of the perfect parallel lines convey a stylized look

05 Esta ilustracion también captura cémo se puede utilizar la
perspectiva aplanada para crear una declaracion artistica. Observe
cémo todas las lineas paralelas perfectas transmiten un aspecto
estilizado.
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BREAKING THE RULES

Isometric perspective is a form of perspective used primarily in
technical drawing. Unlike traditional linear perspective, which uses
vanishing points to convey theillusion of depth, isometric perspective
maintains consistent angles and dimensions for all three axes of
length, width, and height (06). Although isometric perspective isn't
commonly used in traditional art, because it is primarily associated
with architectural drawings, there are instances where it has been
incorporated into concept art. When this happens, it is typically used

to create an abstract or stylized effect in artistic expression.

An additional way to enhance volume and depth is through the use
of curvilinear perspective. One of the key aspects of curvilinear
perspective is the use of the ‘cone of vision’. This cone represents the
area in front of you that you can see clearly, while objects outside
of this cone appear more distorted and curved (07). It's important
to understand and work within this cone to maintain the illusion
of depth and space in the artwork. Another fascinating aspect of
curvilinear perspective is that it can create a sense of movement and
dynamism in compositions (08). The curved lines and arcs suggest a
dynamic flow in a scene, which can add energy and interest.

06 This demonstrates the use of isometric perspective in order to achieve a plan-like view of

the landscape. This type of perspective has been widely used in simple video-game platforms.
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07 Here you

can observe the

use of curvilinear
perspective in order
to accommodate the
distortion viewed
through a wide

cone of vision.

08 Here curvilinear
perspective is used to
create direction and
dynamic movement

inascene.

Making certain objects or figures
larger or smaller than they should be in
reality can convey a sense of drama or
emotion. By playing with scale, objects

can appear disproportionately larger
or smaller within the scene to evoke a
sense of wonder or distortion. Embrace

distortion techniques like elongation,

compression, or exaggeration to achieve
creative effects.
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Image © Devin Elle Kurtz

1 always aim to create illustrations that
feel visceral and alive, with an immersive
quality that pulls viewers into the image and
holds their attention. Lifelike perspective
and depth are key tools for achieving this.
In order for my illustrations to feel like real
and believable spaces, they must contain
convincing perspective and a true sense
of depth.

Throughout my years as a production artist

painting environments for both animation

and games, I've developed a number of

speed and efficiency tools for the purpose

of achieving the maximum artistic impact,
while working at the (sometimes frantic)
pace that many productions require. This
tutorial aims to take you through a number
of these digital efficiency techniques, and
to hopefully make painting complex city
scenery feel less daunting and more easily
achievable. Buildings are largely just a
collection of boxes and rectangles - the
most basic of three-dimensional forms and
the easiest to put into perspective. With the
right tools and knowledge, anybody can learn
to construct an appealing city scene out of
these simple shapes and forms. I will be using
Clip Studio Paint for the initial construction
drawing, followed by Adobe Photoshop for
the remainder of the painting process, but
you can follow along with your program or
medium of choice.

DEVIN ELLE KURTZ

DOWNTOWN DRAGONS

A







TUTORIALS

01 GATHERING
REFERENCES

On the Saturday night of San Diego
Comic-Con this summer, I walked through
downtown San Diego with a group of friends.
One of them commented that the golden
hour scenery looked a lot like a ‘Devin Elle
Kurtz painting’- and he was right! Nestled in
the hazy mist of the sea, downtown San Diego
is one of my favourite locations to explore
for inspiration. Towering skyscrapers reflect
different pieces of the sunset sky on every

face, horizontal shafts of light beam through
alleyways, and the whole city glints with
gold and blue.

When I set out to gather references for
this project, I looked for a few things in
particular: I wanted to capture buildings
of other

reflecting in the windows

buildings, structures casting shadows
onto one another, and window towers
reflecting glimpses of skies out of frame

(01a-d). These are all city characteristics

that leave me feeling awestruck and inspired
by the scale and dynamism of the world
around me. When you gather references for
your projects, wherever you choose to go, try
to walk through the streets like a director.
What draws you into the depth and scale of
the environment around you? What aspects
of the space you're photographing leave you

feeling full of awe?

01a - 01d A few of the photos | took as reference for this illustration, shot on my trusty old Canon 6D with a wide lens, then edited in Adobe Lightroom.
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If you have the chance to visit a large city, try to find a skyscraper rooftop that

you can publicly access. This fresh perspective of the cityscape will lend itself to
exciting reference material, so bring a camera (or your phone!).

02a - 02d various greyscale thumbnail explorations, composed with shape and value instead of line.

02 ROUGH VALUE
THUMBNAILS

Rather than using just one photo as a
direct reference, I want to design a brand-
new composition - something inspired
by bits and pieces of the photos I've taken,
but stitched together into an entirely
new arrangement. I'm working with the
Rectangular Marquee tool, the Gradient
tool, and a hard round brush. I lay down
shape and value with no consideration for
careful mark-making or line quality. At this
stage I'm searching purely for an appealing
composition in its most basic form (02a-d).

If you typically sketch with line, challenge
yourself to try composing in value when
working with city imagery. Because cities
are composed of such simple shapes, you
can achieve a fairly accurate glimpse of what
the finished composition might look like,
even at this early thumbnail stage.

I don’t concern myself with accurate
perspective here, so long as the composition
reflects an arrangement of shapes that could
roughly exist in reality. I slowly find the
story of the image as I work. From the start
I know that I want to paint a piece for my
city dragon series. As I sketch, I'm inspired
by the concept of a mother and baby dragon,
flying in and out of the long afternoon
shadows cast by the skyscrapers. It presents
an enticing challenge: establishing a smaller
subject in the foreground, while a much
larger version of the same creature must sit
back in the background. This is a reversal
of one of the most important depth cues —
objects and subjects typically reduce in size
as they move back in space.
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03 SETTING UP A
PERSPECTIVE GRID

Having selected the mother and baby dragon
concept (02¢), I take it into Clip Studio Paint fora
drawing pass. You can create a perspective ruler
in Clip Studio Paint by selecting Layer > Ruler >
Create Perspective Ruler. For this piece, I use a
three-point perspective grid. A collection of lines
will appear on the screen. The horizontal line is
the horizon line. Start by dragging that line to
wherever your horizon should be. In this case,
it's down below the bottom of the canvas. Next,
you can adjust the two points that sit along the
horizon: the vanishing points (VP1 and VP2).
These are the perspective points present in a
two-point perspective grid and they always sit
along the horizon line. If you're unclear about
where the horizon should be in your drawing,
you can place these two vanishing points first
using lines in your thumbnail, and then connect
them to locate the horizon. Drag the lines
radiating out from the VPs to roughly match
up to your thumbnail. Finally, drag the third
perspective point into position. Here the third
VP is placed a great distance off the canvas in
the sky - this will create drama, but not too

severe of an up-shot (03a, 03b)!

Although I paint in Photoshop, this
year I started using Clip Studio Paint’s
intuitive perspective rulers to build the
majority of my perspective grids. It's
easy to switch the ruler on and off with

the visibility of the layer it occupies,

which is useful. I don’t always match
the perspective perfectly with every
line, particularly when drawing older
and quirkier architecture. Sometimes
imperfections are needed to create
character and a feeling of history.

VP3

03a & 03b A recreation of the perspective grid, coloured for additional

clarity. Try to match the perspective lines roughly to the thumbnail,
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04 An early block-in sketch of the cuboid buildings, colour-coded for clarity.

If you struggle to see and understand perspective, try tracing directly on top
of city photos and following the perspective lines until they converge. Find
the VP1 and VP2 by tracing the horizontal lines of the buildings, and then
connect them to find the horizon line. Next, trace the vertical lines to see
whether they converge above or below the horizon line. This exercise will

help your brain start to make connections between what you see visually and

the underlying perspective.

04 SKETCHING THE
BASIC BUILDING BLOCKS
If the perspective in your thumbnail is too
nonsensical to match easily, you may need to
experiment. Place the vanishing points (VPs)
somewhere in the general vicinity, try it out, and
see how the sketch looks. You can always move
the VPs and try again if the resulting perspective
is too flat or too severe. Over time, you will gain
an intuition for how the position of each VP will
impact the perspective in your drawing.

Once you're satisfied with how the perspective
looks, it's time to turn down the opacity on
the thumbnail and create a block-in pass. Each
cuboid building in three-point perspective
will have a set of lines that converge to VP1, a
set of lines that converge to VP2, and a set of
lines that converge to VP3. If you find yourself
getting confused, it may be useful for you to
use a different colour to sketch each set of
converging lines to encourage your brain to
start separating the sets from one another. The
goal is to eventually be able to easily distinguish
which VP any line in your drawing converges to,

even when drawing in one solid colour.
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05 CUTTING CORNERS

Composing with box forms is an easy way to quickly lay in a city.
Boxes are the easiest form to put into perspective. If you want to
spice up your boxy skyline and introduce more interesting building
shapes, you can carve out sections of some boxes to create new
planes and more unique silhouettes.

Draw two parallel lines in perspective from front to back, top to
bottom, or side to side on two adjacent planes (A). Then, connect the
end points of those lines (B) to create a new plane cutting through
A. B. your box form at a diagonal angle (C). This technique can be used to

efficiently craft all sorts of interesting buildings, without needing to

c: /I\

05a - 05¢ | use the corner-cutting technique to carve out a fifth face on the main building in my drawing.
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06a An example of adding a curved face to a box

use reference points on the horizon line. Use this technique to add

diagonal slants or make a building with five (or more) sides (05a).

You can quite easily find the midpoint of any plane in perspective
by drawing an X from corner to corner (05b). This technique can
be used to carve out planes or sections in a proportional way, or to

divide buildings into even sections (05c).

06 DRAWING A CURVED BUILDING

It’s possible to add a curved front face to a box too (06a), which can
be translated onto a curved building (06b). First, cut a vertical plane
out of somewhere in the front-middle section of the box by following
the perspective (A). To create a subtle curve, cut out a shallow section.

For a deep, round curve, cut a plane further into the middle of the
box. Second, drag a circle out using the Shape tool in your chosen

software, then use the Rectangular Marquee to cut the circle in

half and delete the bottom half. Select Transform > Distort if using
Photoshop or Procreate, or Transform > Free Transform if using Clip
Studio Paint, and a bound box will appear around your half circle.
Match the corners of the bound box to the four top corners of the

section you cut out of your box. Repeat with the base, draw around

the perimeter, and you will have an easy, efficiently drawn, curved
building (B). To add windows that match the curve, you can draw the

window facade flat (C) and then use Transform > Warp to curve it
around the building, using the top and bottom curves as guides (D). 06b | eyeball a curved building on the left of my drawing.

I'll figure out the curves more precisely at the painting stage.
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07 SKETCHING

THE DRAGONS

As I sketch the dragons, I envision them
in the real, three-dimensional space they
occupy. I want the mother dragon to cut
through the buildings, forcing viewers to
recognize the depth in the scene. Overlapisa
key tool for depicting depth. I make sure that
she’s nestled amidst the buildings: in front
of distant buildings and behind foreground
structures. Overlaps in busy city scenes can
be challenging to achieve without causing
tangents (places where two lines awkwardly
touch and make the spatial positioning
unclear). Whenever possible, try not to
create overlap at the very edge of a form.
The more breathing space you can give each
overlap, the better visual clarity there will
be. Generally, try to avoid overlapping right
in the middle of a form. A 30:70 or 20:80
distribution will, in most cases, feel more
organic and appealing. Finally, avoid placing
objects too close to one another without
overlap. The tension can become distracting

and produces a flattening effect.

08 PAINTING A

VALUE KEY

I use Photoshop to expand my initial
thumbnail into a full value key. The general
formula I follow is to decrease the contrast
and narrow the range of value as objects
recede into the distance. In the world around
us, the space between objects is full of fog,
debris, and other particles. The further you
are from an object, the more particles will
be in the air between your eyes and the
object. These particles cause distant objects
to present with lower contrast, fewer details,
and fuzzier edges within shadows.

The baby dragon is closest in space, followed
by the foreground building it silhouettes
against. I give this lower left section of
the painting the widest range of values,
from very dark darks to very light lights.
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07 The finished sketch, depicting the dragons flying through the city.

1 methodically decrease the contrast and
narrow the value range of each subsequent
spatial plane of the environment, with the
most distant buildings simplifying into a
very narrow value range.

I use shadow and light to create a sense of
depth and distance between the foreground,
middle-ground, and background buildings.

Sunlight cuts through a gap and illuminates
the distant buildings, while the foreground
and middle-ground buildings remain mostly
in shadow. This separates the foreground,
middle ground, and background from
one another.
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08 The final value key for my painting; the foreground contains a wide value range, while the background has a narrower value range
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Colour key 01

T s oY

09a Colour key O1: painted

directly from the line art.

09 PAINTING COLOUR KEYS

I use a variety of Photoshop techniques to explore colour and light
in my colour keys. In some, I start fresh from the line art alone (09a,
09d), and rather than trying to make use of the value key, I use it only
as reference and experiment directly with painted colour. In others,
I start by using a gradient map on top of my value key to experiment
with colour and mood (09b), and then paint on top until I achieve a
pleasing result (09c).
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Colour key 02
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09b Colour key 02: created using a

gradient map with little to no paint on top.

If you want to try exploring colour using a gradient map, you can do
so in Photoshop, Procreate, Clip Studio Paint, or other digital painting
software. Gradient maps work by mapping colours you select to each
value zone of an image. In order to retain your value structure, you
will need to pick colours that generally align in value to each value
range you assign them to.
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Colour key 03 | Colour key 04
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09¢ Colour key 03: | used a gradient map initially, 09d Colour key 04: painted

before finishing by painting directly on top. directly from the line art.

After experimenting, I'm happiest with 09¢, and decide to move
forward with it, while remaining open to changing it as I paint.
I'll talk more about how the colours I chose interact with depth in
the coming steps.
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This tip will show you how to use basic boxes as guidelines
to sketch all kinds of unique forms in perspective. All you
need is a little geometric knowledge and the Transform tool.
These skills can be used to add set-dressing and personality to
your cityscapes.

Starting from a fairly even box (A), use the Shape tool to drag
out a perfect circle, and then transform that circle so that the

If you carve a slanting triangular section out of the top

of along box (F), you can construct a rubbish bin (G).

four corners of the bound box match up perfectly with the
four corners of the top and bottom planes of your box (B).
Now, if you connect the top and bottom circles (C), you have
a cylinder in perspective. You can construct all sorts of city
details out of a cylinder: round buildings, poles, and silos to
name a few. Using the ‘X’ technique to find the midpoint (see
page 90), you can create a cone-shaped roof (D) and turn it
into a water tower (E).

Using the ‘X’ technique to find the centreline of a tall,
narrow box (H, I) will allow you to construct a welcome
sign (]).
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You can easily place complex forms in perspective by each corner following the perspective grid. Here I construct
transforming the flat version of the complex face onto both  a letter from a giant sign that could sit atop a skyscraper,
the back and front of the box it occupies (K), then connecting  generously covered in bird droppings (L).

If you struggle with conceptualizing the way forms can be Here I use the Curve tool to create a curve on the top plane

‘carved’ out of a 3D box, try playing around in the free web  (M). I use the Push/Pull tool to carve it out of the box form (N),
version of SketchUp. You can use the Rectangle tool to draw  and watch as the new carved-out form appears right in front
out a rectangle on the ground plane, then use the Push/Pull  of my eyes (O)!

tool to pull it up into a building. Next, use the Curve or Line

tool to make a cutaway shape on a plane of your choosing.
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10 The sky gradient is established using the Gradient tool.

10 SETTING UP MY LAYERS

With a finished sketch, value key, and colour key ready to use, it's
time to paint. I lower the opacity on my sketch layer and begin work,
starting by setting up folders: one for each general plane of the
image. At the bottom of my layers is the sky folder, then the distant
buildings, then the mama dragon, followed by the middle-ground
buildings, the foreground buildings, and finally the baby dragon at
the top of my layer structure. When organizing my layers, I generally
put the ‘closest’ object at the top of my Layer menu, while putting
the object ‘furthest away’, which is often the sky, at the bottom of the
Layer menu.

Keeping the different spatial planes layered and grouped like this
is immensely helpful when painting an image with a lot of depth.
It allows you to easily add global light and atmosphere to each spatial
layer, plus to always retain the overall silhouettes of each section.

With my layers and groups established, I scroll down to my sky folder
and use the Gradient tool to establish the colours of the sky. A layer
of thick atmosphere is catching warm light towards the horizon, and
I use a saturated salmon pink to indicate that layer of fog.

:
=
-

11 The distant buildings are blocked in using the Lasso tool.

11 BLOCKING WITH

THE LASSO TOOL

I love using the Polygonal Lasso tool to block in buildings, as
it'’s exceptionally speedy. I click on each corner of the building,
complete the lasso shape, and then fill the building in with the
appropriate colour. Keyboard or button shortcuts also help to speed
up this process, allowing me to instinctually move between tools.
In Clip Studio Paint, the rectangular selection tool is capable of
automatically following your perspective rulers. This can speed up
the process of blocking in buildings in perspective.
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12 The initial colour base pass of the buildings, all painted using the Lasso tool.

12 SETTING UP DEPTH WITH HUE

Hue can be used to indicate depth and create a feeling of distance,
in addition to the value structure. Grouping the spatial planes of the
environment into general hue families, distinct from one another,
helps to visually separate each layer. Even in this very simple block-
in stage, there is already a sense of the depth. The most distant zone
of the image groups into light warms. The middle zone groups into
midtone cools. The foreground graduates into rich, deep warms.
These hue cues aid the value and size cues in establishing a clear read
of the distance and depth.

13 BLOCKING IN THE DRAGONS

1 pull colours that are already found within the composition to
establish the dragons, but lean the lightest yellow towards a whiter
cream to give them a unique pop against the backdrop. Pulling from
comfortably within the existing palette for the main subjects creates
harmony within the image, but means you must be strategic about
placement, value, and silhouette in order to achieve a clean and
instantaneous read of the scene.

13 The initial colour base of the dragons, blocked in with the Lasso tool.

For example, with the mama dragon, I place the shadow across
the body very purposefully. It allows the bottom two-thirds of the
dragon to silhouette neutral-cool against the warm yellow sky. In the
top third of her body, the warm creams and pinks silhouette lightly
and warmly against the cool, darker sky. This creates contrast and
separation all the way around the dragon, even as the backdrop
graduates colour drastically from top to bottom. I make sure that
the colour of the mama dragon is more muted and dull than the
buildings she passes behind, to stay in line with my value and hue
formula for depth.

The baby dragon is easy to silhouette lightly against the dark
foreground building, but I have to be careful not to lose the cool
shadowed wing. The cool versus warm contrast against the building
allows the silhouette to remain readable, even with the shadow
transition across the lower wing.

29




TUTORIALS

14 The windows of the curved building blocked

in as a flat facade using the Line tool.

14 ESTABLISHING THE

WINDOWS FLAT

Throughout the rest of the block-in process, I will be establishing
flat tower windows, and then using Transform to put them into the
correct perspective. This technique is perhaps the most important
for accelerating the city-building process. Drawing windows in
perspective one at a time is sluggish and monotonous. It’s also harder
to design unique window patterns in perspective. Blocking windows
in flat, without perspective, allows you to design creatively using the
Rectangle tool or Line tool. Afterwards, you can accurately place
your window tower into perspective all at once using Transform.

This technique works for any number of flat surfaces in perspective;
signs, posters, even entire building facades. I will transform these
flat surfaces in various ways, depending on the shape of the building.
For standard buildings with flat faces, I'll use Transform > Distort.
For buildings with curved faces, I'll use Transform > Warp. Here I use
the Line tool to eyeball the vertical window panes on the curved
building first, then draw out the horizontal panes flat on a new layer.
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15 The windows have been curved to

match the face of the building.

15 TRANSFORMING WITH WARP

I use Transform > Warp to warp the windows onto the curved face
of the building. Warp transformations take some practice to master.
You can practise using the technique described in step 06. Warp is
useful for laying flat patterns onto any number of organic or curving
surfaces, such as cylinders or rippling fabric.

It's important to keep the scale of each building in mind when you
draw the windows. If the windows appear too large or too small,
it will disrupt the depth of your painting. If the windows appear
too wide or too narrow, it will interrupt the perspective read of
your image. This can take some practice to gain an intuition for.
I recommend painting studies of photos to develop a sense of the
window sizes in various situations.
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16 Windows are added to the middile face of the tower.

16 TRANSFORMING WITH DISTORT

I create a square window brush to easily draw out the windows of the
five-sided tower. (You can learn how to do this on the next page.) Next
I use Transform > Distort to apply those windows to the middle face
of the building. I save a copy of the flat windows so that I can use it
for the left and right faces as well.

It's beneficial to have a construction drawing of the entire building,
even if it means temporarily extending your canvas. This allows you
to easily match the four corners of your window tower to the four
corners of the plane it’s being applied to, enabling you to line up each
row of windows on adjacent sides of the building.

101




TUTORIALS

In this section, I'll be explaining how to create window
brushes in Photoshop. The process is very similar in both Clip
Studio Paint and Procreate. Window brushes can be used to
save time when drawing out the flat tower windows for cities.
I have a set of free city window brushes for all three programs
available on my Gumroad store if you want to experiment
with pre-made brushes. You can find my City Brushset here:
tamberella.gumroad.com

Start by using the Rectangle tool to create a single window

(A). This window should be pure black against a pure
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white background. Next, select the window and hold
Option+Command+Shift and drag to the side to copy that
window repeatedly, until you have a horizontal line of
windows (B). This will be one row in your window tower, and
the base for your brush. Now, select the whole line using the
Marquee tool and select Edit > Define Brush Preset. A Brush
Name dialogue box will pop up. Name the brush and select OK
to save your window stamp. Next, you can edit the stamp in
the Brush menu to turn it into a usable brush. Go to Window >
Brush Settings to open the Brush panel.

Brush Settings




Select Brush Tip Shape to get to this page of the menu (C).
Temporarily set the angle to 90 degrees. You will change the
angle back to 0 later, but you need to adjust it now in order
to see the spacing of the brush in the brush panel. Next, drag
the bar under Spacing until the rows of windows separate
from one another. You can create a wide gap or a narrow gap.
Once you're satisfied with the spacing between your window
rows, reset the angle to 0 degrees. Click the + at the bottom
right of the window to open the dialogue box to save and name

your brush.

Now, you can hold Shift and draw in a vertical line to easily
create a window tower (D). Finally, use Transform > Distort to
put it into perspective in your painting (E)!

DEVIN ELLE KURTZ: DOWNTOWN DRAGONS

Repeat these same steps with a variety of window shapes and

configurations to build your own unique library of window

brushes. Vary the size, shape, and spacing of each window
row to create endless variations (F). Once you have a stockpile
of window brushes, blocking in a skyline is quick and easy!
Lock the window layer to add reflections or illuminate lit
windows at night (G).

RRRRRERRRRRRRRNE
(AERERNEENNNRRRRRUNE!
mnnnnnn [AARERRRNARY]
(AR REEUNRRRERRRER
(ARRRNE] ( NURRRRRRNE!
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17 MAINTAINING THE
LAYER STRUCTURE

I repeat the Transform > Distort process on
the left and right faces of the tower. I keep
each of these transformed window columns
on their own layer, clipped to the base. It’s
key to keep things like windows layered out,
sothatthey can belocked and painted within
at various stages of the process. I try not to
merge anything until I'm fully satisfied with
my composition and am only making final
touches. This may be a challenge if your
computer or tablet struggles with large files.
If you need to merge layers to keep your
software running smoothly, try saving out
selections or silhouettes instead.

18 REFLECTIONS

IN WINDOWS

I use the same Transform > Distort process
to add a unique pattern of windows to
the building in the lower right of the
composition. Next, I block in reflections.
Windows are not perfect mirrors, so the
scenery that they reflect is distorted and
discoloured compared to the source material.
They reflect a warped version of reality,
which allows you to be creative and use their
reflections to the benefit of the composition.
They can reflect colours entirely out of the
frame of the canvas, allowing you to add
fresh, contrasting colours if the composition
needs them (18a).

Because each window is its own surface,
there is typically some variation between
what is reflected in one window compared
to its neighbour (18b-e). Replicating this
uneven, disjointed quality by selecting
a handful of windows and moving or
recolouring them can very quickly add
realism to your painting.
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17 The tower is now fully covered with windows.

18a The lower right-hand building with disjointed, wavy reflections on the window surface.
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18b Photo reference: Note the condensed, highly warped appearance 18¢ Photo reference: Windows that are even slightly
of reflections in curved buildings. Observe how the reflected concave or convex will create greatly distorted
hues are warmer and darker than the source material. reflections that stretch oddly around each edge

18d Photo reference: This building has narrow 18e Photo reference: The window leading and reflections
sections of glass that cover walls, plus wider sections vary in the lit areas versus the shadow areas. The leading
that open transparently into the offices. Note how is darker than the windows on the shadow face, and

the reflections vary between the two sections. lighter than some of the reflections on the lit face.
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19 PAINTING A

FLAT FACADE

This tutorial has already covered flat tower
windows that are distorted into perspective
(page 102). You can also use this technique
with entire building facades. It's much easier
to proportionally design a flat building
facade than to try to draw all the details
individually in perspective. When working
flat, you can use the Symmetry tool to mark
out distances. Hold Option+Command+Shift
to easily copy out parallel elements on the
same layer. It’s easier to focus on design and
creativity when working in flat perspective.

Here I paint a facade for the building on
the lower left. I keep the windows on their
own layer, as well as the columns and cross
elements that will need to separate from the
main surface to read with accurate depth.
Now I can group the entire painted facade
into one layer group, and then transform
that layer group into perspective while

retaining the layer structure.

20 TRANSFORMING
THE FACADE INTO
PERSPECTIVE

I use the Transform > Distort technique
to move my facade into perspective. You'll
notice that it looks very flat and unrealistic
at the moment, like a facade painted onto a
building, rather than a real one with depth.
At this stage, take note of which elements
of your facade need to nudge in or out in
order to create a feeling of depth. Here the
windows should nudge left and down to sit
deeper into the wall, whereas the columns
should nudge right and up to come forward
from the wall.
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19 The flat facade is blocked in.

20 The flat facade is transformed into perspective.
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21a The facade with depth added to the windows.

21b The facade with depth added to the columns.

22a The building before shading.

21 GIVING THE

FACADE DEPTH

Giving the windows depth is a multi-step
process. First, I duplicate the window layer.
1 select the copy on top and clip it to the
original window layer with a clipping mask.
Next, I fill the base window layer with a
darker colour. Finally, I select back onto the
lighter window layer on top, and with the
arrow keys I nudge that layer down and to
the left to situate it deeper into the building.
Because the lighter windows are locked to
the original base, this creates a feeling of real
depth (21a).

Second, I repeat this process with the
columns, but nudge them in the other
direction in order to lift them away from the

22b The building with shading, creating depth and a sense of realism.

building (21b). I also copy windows onto the
two side sections. You can repeat these steps
with any number of elements in order to
create depth and volume.

22 SHADING

THE BUILDING

I follow the perspective grid to fill out the
rest of the building (22a), then begin my
shadow and light pass. Alongside reflections,
cast shadows are a way you can indicate
scenery outside the bounds of the canvas.
Indications of a world outside the frame
make the space feel more real and add to the
sense of depth by reminding viewers that
there is a world behind the ‘camera’.

I add a cast shadow zigzagging across the
front plane of the building using a cool
purple-grey colour set to Multiply, then add
a warm light in the space outside of the
shadow using an Overlay layer. When adding
cast shadows across building facades, make
sure that you adjust the shadows based on
the depth of each element of the facade.
The columns in my painting come forward,
so the shadow across them sits higher than
the shadow line across the building beneath
them (22b). These small variations in the
shadow line do a lot of heavy lifting when it
comes to imparting volume and dimension.
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23 A close-up of the rendered buildings in the

distance, with added roof elements.

23 RENDERING THE

DISTANT BUILDINGS

Next, I render out the most distant buildings. I keep them relatively
simple, including only enough detail to make them feel real and
populated. The heavy atmosphere and bright blooming sun will
simplify these buildings considerably by the end. I add some roof
structures across various buildings too. Little noisy details on a roof
can add a lot of realism to a city skyline. I maintain the very narrow
value range in the distant buildings, as I want them to sit back solidly
into the distance. Consider a ‘less is more’ approach when rendering
your distant buildings. Too much contrast and detail will break
the illusion of depth, pulling too much attention from your middle
ground and foreground.
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24 A close-up of the building with arched windows, which have been

transformed into perspective. The flat version of the windows are shown above.

24 VARYING THE DETAILS

I use a similar process with these arched windows as I did with the
windows in step 21, first clipping them to a darker base and then
nudging them over using the arrow keys. As these windows are
larger, I include a dark reflection of the overhang by erasing out the
sky reflection along the outer right rim. Because the grey window
leading sits on top of the reflections without being impacted by their

colour variation, it makes the windows feel more real and solid.

Throughout your cityscapes, try to vary both the macro and micro
shape language. This will help your cities to appear more lifelike and
interesting. I try to give each building a unique silhouette, window
shape, and proportion. The smaller buildings in a city are typically
the oldest, with the architectural aesthetics of a bygone era. These
older buildings tend to have more ornate design elements and more
unique window shapes, designed in a time before sleek minimalism
took hold.
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25a My current painting progress in colour. 25b The painting in greyscale, which is useful for checking the values.

25 CHECKING THE

VALUE STATEMENT

Pause to check your values from time to time to ensure you're
staying on track with your value goals for the painting (25a). It can
be easy to get lost and ‘lose the plot’, especially when working on
an environment as complex as a cityscape. I keep a layer filled with
pure black set to the Colour blending mode at the top of my layer
structure. This allows me to easily check my values at any time
during the painting process. I find this digital greyscale conversion
process to be a lot more accurate than using the Desaturate feature
or the Saturation slider.

When looking at my current progress in greyscale, it feels in line
with my goals for the image (25b). The distant buildings illuminate
against the sky, the middle buildings group into a wider (but still
fairly neutral) midtone value range, and the foreground buildings
contain the highest contrast and widest value range. This is a green
light to continue without needing to make any major adjustments.
If you find your values no longer align with your plan, take some
time to make adjustments before progressing further with the
rendering stage.
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26a A detail pass across the curved office tower.

26 DETAILING THE

CURVED BUILDING

Using reference photos of curved buildings from my walk through
San Diego, I add a reflected building and some other reflected details
to the curved tower on the left (26a). I look closely at my reference
and notice that various bits of the reflection curve diagonally across
warped windows (26b). I do my best to mimic this effect, selecting
individual windows and drawing in swooping motions within them.
Ialso add lights within offices inside the building. These tiny specular
lights are to remind viewers of the scale.

1o

26b A close-up of a reference photo | took of a curved building in downtown San Diego.

27 DETAILING THE MAIN

WINDOW TOWER

Next, I detail the main tower. I add building reflections in the
middle face, using reference photos as a general guide for how
these reflections might ripple and warp across the many individual
windows. I also include subtle indications of windows on the
reflected building. Little details like this will generally go unnoticed,
but will add to the overall immersion and reality of the painting.

I select windows here and there to lighten and darken, maintaining
the overall gradient but breaking it up with imperfections and noise.
I also pick some sections of window panels to darken, a feature I
see in various reference photos. I add some subtle drips from those
panels, perhaps fluid from AC or ventilation.
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27 A close-up of the main tower, with added reflections and window rendering.
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If you find that you’re struggling to separate the spatial planes
of your environment, try using the Lighten blending mode.
This blending mode comes closest to portraying how fog and
atmosphere truly interact with real-life distant objects. The
technique will allow you to first paint your scenery using a
full value range, then add atmosphere on top to suggest depth.

Indiagram A, the buildings are all painted with a similar value
range, which flattens the composition. In diagram B, I use
Lighten layers to create a feeling of depth in the image. Note
how the highlights mostly remain intact. This is fairly true to

how fog and atmosphere interact in the real world.

If you want to try this technique, first use the Rectangle tool
and window brushes to block in a rough city skyline. Make
sure to keep each building on its own layer, with the furthest
building at the bottom of your Layer menu and the nearest
building at the top of your Layer menu. Next, clip a layer set
to the Lighten blending mode to each of your building layers.
Finally, fill the Lighten layers with a neutral colour that
resembles the general sky and atmosphere, working from
back to front. Use a light version of your neutral colour to
lighten the most distant buildings, then slowly darken the
colour as you approach the foreground (C). Experiment with
various hues to try out different effects!
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28a & 28b The first (28a) and second (28b) paint pass across the mama dragon.

28 PAINTING THE MAMA DRAGON

To render the mama dragon, I begin by taking the colours already
present in my block-in pass and use them in a detail pass across the
dragon (28a). Next, I follow with a pass intensifying the cool shadows
and warm light (28b). I want the dragon to appear as a colossal figure
within the image. A creature at this impossibly large scale needs to be
handled differently than a creature of typical scale. An organic form
this large will inevitably contain a great deal of texture and detail.
Due to the distance, and therefore the atmospheric perspective, this
detail must only be hinted at in my painting, particularly in the
shadow masses. Fully rendering the dragon’s body with scale and
skin details would ruin the immersion and depth.

The terminator line (the division between light and shadow) is
a choice location to display hints of detail in a huge and distant
form. I concentrate texture, noise, and detail right at this transition
between light and shadow, hinting at tiny scales, skin folds, and

14

other surface variations. I use bounced light from the glowing city
below to illuminate anatomical detail across the dragon’s chest
and body. The lower wing is detailed through subsurface scattering
alone. Subsurface scattering describes the warm, saturated glow that
appears within semi-translucent materials as light penetrates the
surface and is scattered wildly inside. This phenomenon is present in
the translucent membrane of the dragon’s wings, neck fins, and tail
fins. You can observe this in your own body by holding a lit torch up
against your fingers.

I keep the interior shadow and bounce light zones mostly absent
of detail, signalling to the viewer that a great deal of atmospheric
interference is present. This atmospheric interference is interpreted
as distance. Shadows group into one midtone mass, with crevice
shadows and details disappearing into the larger shadow form. Only
the face and upper wing, illuminated by sunlight, are allowed more
detail and rendering.
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29 RENDERING A

CLOSE-UP SUBJECT

Rendering the baby dragon in the foreground requires largely the
opposite of what I've done for the mama dragon in the distance.
Where the mama dragon’s shadows group onto one flat mass, the
baby dragon’s must expand into subtle value transitions and rendered
crevices (29a). I include lots of tiny spikes, scales, and specular
highlights. I render the skin folds of wings, the shine in the eye,
and whisker-like lines on the nose and chin. Subsurface scattering
illuminates the thin membranes of the lower wing in shadow.
During this rendering process I also elongate the baby dragon’s tail,
encouraging a sleek and aerodynamic appearance (29b). I render
each body part with a wide range of colour and value. This pulls
the dragon close to the camera, as it displays very little atmospheric
interference. This value and colour range will widen even further as

the painting develops.

29a & 29Db The first (29a) and second (29b) paint pass across the baby dragon.
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30 DETAILING A
MASSIVE DISTANT
SUBJECT

Painting a subject that is both very large
and very distant presents some unique
challenges. If your silhouette and form
appear too simple, the scale of the subject
will not read correctly, so a degree of
silhouette complexity and overall noise must
be present. However, if that noisy detail is
given too much value contrast, the illusion
of distance will be broken and your subject
will not settle back into the atmosphere.
Therefore, you must be careful to include
noisy silhouette changes and details, but
they must be placed and coloured very
strategically in order to achieve a proper
impression of distance and scale.

I've already mentioned the efficacy of
detailing along the terminator line, and you
can note the various details I've placed along
the divisions between light and shadow
forms. The overall silhouette of the subject
is another handy location to add indications
of small details. I break up the dragon’s
silhouette with a variety of silhouette
details (30a) — particularly details that hint
at the dragon’s age, such as wear and tear on
the thinner membrane of the wings (30b).
The value diagram (30c) shows how the
values are handled differently between the
mama and baby dragon.

30a A close-up of the detail in the mama dragon’s silhouette and form.

30b Details such as tears in the wing hint at the dragon’s age.
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30c¢ A diagram depicting the difference in value range between the mama and baby dragon.




TUTORIALS

31 A close-up of the trees and telephone wires at the bottom of the painting

31 ADDING SCALE CUES

I introduce additional details to the bottom section of my painting

to further the depth and distance read. Including multiples of the

same object, such as trees or telephone poles, at various distanc
throughout your painting is an effective way to show the viewer

exactly how much distance elapses between each repetition of the

object. If it’s an object that is easily recognizable, such as a bird or
a street sign, viewers will immediately be able to cue into the
of the object, and will therefore have a reference point for the
of your overall image. You can scale objects or subjects into your

environment by following the lines of your perspective grid.
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Placing the little dragon in front of these recognizable scale cues
helps us to recognize just how much smaller it is compared to its

mother. Dragons sure must eat a lot to grow that much over the

course of their lifetime!
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32 An example of the various silhouettes | save as alpha channels in this illustration.

32 SAVING SELECTIONS

OF SILHOUETTES

As you draw closer to the finish line of your illustration, it may be
beneficial for you to save out selections of your major silhouettes.
You can use these silhouettes to easily make final adjustments to the
image. I will detail how to do this in Photoshop.

Determine which silhouettes you want to save out. I generally
save out each of the major buildings, each of the major subjects,

120

and then general selections for the foreground, middle-ground,
and background planes. If, for instance, your background plane
consists of five or six different buildings, it may prove tiresome to
scroll through the Layer panel and select each one individually in
order to perform a value adjustment to the entire background plane.
Compiling all of those silhouettes together into one saved selection
will speed up the process of doing final adjustments.




Before

33a The painting before my adjustments.

In Photoshop, you can select all of the pixels present on a layer by
holding Command and selecting the layer thumbnail in the Layer
menu. Select all of the objects or subjects that you want in your first
saved selection, and then go to Select > Save Selection. The selection
will now appear as an alpha channel on your Channels panel,
which you can summon by selecting Window > Channels. Repeat
this process until you've saved out every selection you'd like to be
able to pull up easily. To reselect a saved selection, hold Command
and then select the thumbnail of its alpha channel on the Channels
panel. Now, you can easily reselect your major silhouettes and use
adjustment layers to easily shift the hue, value, and contrast.

If using a different digital painting program that doesn't allow you to
save selections, you can select your desired silhouettes and then fill
them in with a solid colour, each on a new layer. Keep the visibility
of these layers off, but leave them in a group at the top of your Layer
menu so that you can easily select from them as needed.
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33b The painting after my adjustments.

33 MAKING COLOUR ADJUSTMENTS
WITH SAVED SELECTIONS

I use my saved selections to make hue and value changes to large
areas of my painting using adjustment layers (33a, 33b). You can read
more about these techniques on page 124.

My primary goal is to bring more clarity to the silhouettes. The
painting is currently too neutral in value, so I will be aiming to
create separation and visual impact through my adjustments. The
sky feels too dark, so I use a Levels adjustment to brighten it. I also
use selective colour to lean the hues away from peach and towards
gold, to create more separation between the mama dragon and the
sky behind. Next, I push the cyans and blacks of the main window
tower using a Selective Colour adjustment. This gives it more impact
and pulls it forward in front of the mama dragon. I warm up the
foreground using a Selective Colour layer as well, then create a subtle
gradation in the blacks to ensure they're lighter towards the top of
the foreground buildings and darker towards the base. I add more
contrast to the baby dragon and lean the mama dragon’s shadow
forms towards cyan, rather than magenta.
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Softening or blurring out-of-focus edges is an incredibly going over them with a rake brush, grainy brush, or any other
useful tool for crafting depth. But if a standard Gaussian blur  kind of textured brush. Any brush that breaks up the solid
or airbrush doesn’t suit your style, you can soften edges by  silhouette will allow you to soften or ‘lose’ edges.

34a - 34¢ Close-ups of the noisy details and lost edges across the painting
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34 ATMOSPHERE,

LIGHT, EDGES, & NOISE
Satisfied with my overall image, I zoom in
to do a final detail and paint pass across
the environment. I begin by softening
edges within the brightly lit areas of the

city (34a). The gleaming light bloom from
the setting sun will make these areas look
fuzzy and blinding. Losing edges within the

-
-
-
-
=
-
-
-
-
-
-

AT

light bloom will appear to make the light
intensify. Note the highly saturated, reddish
border between the lit areas and shadow
areas. This light bloom transitions the light
and shadow masses gently, encouraging a
brighter appearance in the process.

I also include hints of texture across the rest
of the painting (34b, 34c) to unify the overall
texture and give the rest of the buildings a
level of noise that suggests their large size
and years of weathering.
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The last ten to twenty per cent of my painting process nearly
always involves making hue, saturation, and value changes
to saved silhouettes using Photoshop’s adjustment layers.
In Step 32, I detailed how I save out selections that I use to
reselect the major subjects and objects in my paintings easily.
In this section, I'll explain how you can use adjustment layers
to balance and finalize your paintings.

Adjustment layers are one of Photoshop’s greatest features.
They allow you to make non-destructive changes to your
colour and value. The changes you make will be tied to a layer
in your Layer menu. You can switch this adjustment layer
off and on, decrease the opacity, change the blending mode,
or mask areas out with a clipping mask. You can create an
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Default
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Properties
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adjustment layer by clicking on the half-light, half-dark circle
at the bottom of the layer panel.

My favourite type of Photoshop adjustment layer is the
Selective Colour tool (A). It allows you to select a hue family
(reds, yellows, greens, cyans, blues, magentas, whites,
neutrals, or blacks) and then manipulate the CMYK values of
just that hue family. Select a colour from the Colour menu, and
then drag the bars left and right to make your adjustments.
You can set your changes to Relative or Absolute. Typically
Iselect Absolute.

Let's experiment by making some adjustments to this
dragon painting (B). First, I try a global adjustment. By

Properties
X B selective Color

Proset: Custom

Colors: Neutrals

Cyan:

Magenta:




selecting the neutrals and decreasing the cyan, increasing
the magenta, and decreasing the yellow (C), we end up with
a lovely, purple-tinted scene (D). I quite like this version of
the image and nearly continue in this direction with my final
painting. Sometimes, playing around with this tool leads me
to discover new colour options for my paintings that I hadn’t
previously considered.

Second, I try using one of the selections to adjust one area
of the painting. Here I select just the silhouette of the mama
dragon. When you select an area first, and then create the
adjustment layer, it will automatically apply a layer mask so
that the adjustment layer only touches the selected pixels (E).
I decide to create a more graphic, solidly warm silhouette
for the mama dragon, something similar to my piece Dragon
Migration, which you can view in the gallery section of this
book (page 259). This would be a more graphic depiction of
distance and scale than the direction I choose for my final
painting. Here I select the neutrals, decrease the cyan,
increase the magenta, and increase the yellow (E, G).

Now let’s try an adjustment more specific to depth and
perspective. Perhaps you have a foreground subject that
feels too light in value to sit solidly in the foreground. Using
a Multiply layer to darken it may feel flat. Instead, try using
a levels adjustment (H). Look at the three triangles on the

top bar first. The leftmost triangle on the top bar allows you

W O Levels
Custom

Preset

RGB
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to push the dark tones darker. The middle triangle allows
you to lighten or darken your midtones. The triangle on the
right allows you to lighten your light tones. The bar along the
bottom allows you to push all values lighter or darker, with
the left triangle pushing values lighter and the right triangle
pushing values darker. This sounds complex, but is quite
intuitive when you experiment with it yourself.

For example, if I want to darken just the buildings in the
foreground, I can select them with my alpha channel, deselect
the baby dragon, and then create a levels adjustment clipped
to the shape of the buildings (I). In my Levels panel, I drag the
midtones to the right to darken them. I also pull the overall
values darker using the bottom bar (J). This results in darker,
richer foreground buildings (K).

You can use these adjustment layers to fix all sorts of depth
issues in your painting. If distant structures or objects aren’t
sitting back into the atmosphere properly, you can desaturate
them, lighten them, and narrow their value range in just a
couple of minutes. If your focal point needs an extra pop of
contrast, you can lean the hue towards a complementary
colour of the surroundings, or increase the value contrast
with Levels. I recommend you experiment with other types
of adjustment layers too, such as Curves, Colour Balance, and
Brightness/Contrast.




TUTORIALS

35 A close-up of the baby dragon with the added blue highlight.

35 ADDING A HIGH-

CONTRAST GLOW

One fun method to make a bright, white highlight appear even
brighter is to give it a neon glow in a hue opposite to the local colour
of the subject. The baby dragon is warm, so I use a very saturated
blue to encourage the white highlights to glisten. This is a technique
I picked up from looking at blown-out photos. When highlights
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blow out in photography, our phones and cameras compensate
by creating a neon border to the highlight. These neon lights tend
to also replicate the way looking at a bright highlight feels in life.
This additional contrast on the baby dragon also pulls it closer to
the camera. You can try this technique using either a Hard Light
blending mode, or a Normal blending mode.




36 A close-up of the foreground, with an additional detail pass.

36 FINAL TOUCHES ON

THE FOREGROUND

Now I begin a final detail pass across the foreground. I spend a lot
of time sitting back and examining if the scaling and composition
are reading in the desired way. I notice that the windows on my
nearest foreground building appear too large, wide, and out of scale.
I can slyly change this impression by adding additional vertical
window leading. This is enough of a shift that the windows no longer
distract me.

Next, I notice that the baby dragon doesn'’t ‘pop’ forward adequately,
so I add some small details to encourage it to ‘pop’ towards the viewer.
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I add a subtle dark rim around the dragon’s perimeter using a soft,
painterly brush on a Multiply layer. This slight drop shadow <ns1:XMLFault xmlns:ns1="http://cxf.apache.org/bindings/xformat"><ns1:faultstring xmlns:ns1="http://cxf.apache.org/bindings/xformat">java.lang.OutOfMemoryError: Java heap space</ns1:faultstring></ns1:XMLFault>